Description

Drained Nonlinear
Analysis of a
Retaining Wall

For LUSAS version: 16.0

For software product(s): | Any Plus version.

With product option(s): | Nonlinear

Note: The example exceeds the limits of the LUSAS Teaching and Training Version.

Description

The behaviour of a single

Original ground level
propped retaining wall is to Zomﬂ
be investigated in the long

term. Drained  soil '

parameters are used 'Eéi?,vgg ?nn
throughout. .

Horizontal displacement is
restrained at the left and
right hand edge and both
horizontal and  vertical
displacement is restrained at
the base of the soil as the
soil rests on solid rock.

101m

The wall is ‘wished-in-place’
in that construction of the
wall is not modelled.

Units of kN, m, t, s, C are
used throughout.

j

‘4 101m
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Modelling

Drained Nonlinear Analysis of a Retaining Wall

Objectives

The required output from the analysis consists of:

U Displacement of the wall toe towards the excavation
O Surface heave immediately behind the wall

O Contours of plastic strain around the excavation

O Prop force per m length of wall

O Bending moment in the wall at 10m depth

Keywords

2D, Inplane, Retaining wall, Drained, Nonlinear, Excavation, Surface heave, Plane
strain, Prop force, Bending Moment

Associated Files

U drained_wall_modelling.vbs carries out the modelling of the example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller
in the Examples Manual Introduction.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command File
> New to start a new model file.

Creating a new model

e Enter a File name of drained_wall

e Use the default User-defined working folder.
e Ensure an Analysis type of Structural is set.
e Select an Analysis Category of 2D Inplane
e Set Model units of kN,m,t,s,C

e Leave the Timescale units as Seconds

e Select a Startup template of None

e Ensure the Layout grid is set as None




| Attributes

Mesh >

| Surface...

| Utilities

Variation...

Modelling

e Enter a Title of Drained analysis of a propped retaining wall

e Click the OK button.

Note. Save the model regularly as the example progresses. Use the undo command
to undo mistakes as far back as the last save.

Note. For a 2D Inplane analysis category the vertical axis is set to be the Y-axis.

Mesh Definition

The surfaces are to be meshed using plane-strain quadrilaterals with a quadratic
interpolation order (QPNS).

e Select the Plane Strain, Quadrilateral, Quadratic elements. Ensure the Regular
mesh option is selected with Automatic divisions so that Modeller uses the mesh
divisions assigned to each line.

e Give the attribute the name Plane Strain quads and click the OK button to add the
mesh attribute to the &% Treeview.

o In the &b Treeview click on the mesh attribute Plane Strain guads with the right-
hand mouse button and select the Set Default option. This will ensure all newly
created surfaces will be assigned the elements defined in this mesh attribute.

General Field Variations

The Young’s Modulus of the soil and the in situ stresses vary with depth and therefore
general field variations are required.

e Select General Field Variation and press Next.

e Enter the function as -6000*Y and the attribute name as y_maod for the definition of

Young’s Modulus with depth and click Apply to add the attribute to the &
Treeview and keep the dialog active.

e Enter a new function as 20*Y and the attribute name as sig_v for the definition of
vertical stress and click Apply.

e Enter a new function as 2*20*Y and the attribute name as sig_h for the definition of
horizontal stress and click Finish.

Note. The LUSAS convention assumes that negative stresses are compressive. The
Y coordinate datum is at ground level and so increasing depth will lead to increasingly
negative Y coordinates. The variations as entered will ensure that stresses increase
negatively with depth while the Young’s Modulus increases positively with depth.




| Geometry
Line >
By Coords...
| Geometry
Surface >
| By Sweeping...
| Geometry
| Surface >
By Sweeping...

Drained Nonlinear Analysis of a Retaining Wall

Feature Geometry
e Turn off the display of the Mesh layer in = Treeview.

il Enter coordinates of (0, 0), (20, 0), (21, 0), (25, 0) and (101, 0) to define four lines
representing the original ground level (all Z coordinates should be zero or left blank).
Use the Tab key to move to the next entry field on the dialog. When all coordinates
have been entered click the OK button.

e Press CTRL-A to select all the Lines just drawn.

él Ensure the Translate option is selected and enter a value of —1.5in Y.

e Click OK to sweep the Lines to create the Surfaces.

Drag a box around these 4 Lines

e Select the bottom four horizontal Lines by dragging a box around them.

él Ensure the Translate option is selected and enter a value of —-1.5in Y.
e Click OK to sweep the Lines to create the Surfaces.

Repeat the preceding commands eight times, selecting the bottom four lines of the
model each time and sweep the lines by -2.0, -2.13, -2.13, -2.0, -2.0, -2.0, -2.49 and
-2.25 metres in Y as shown above.

Point B/\

EJ
Point A @J

e Select Point A shown.




Modelling

|GeFf’(;nin‘:"y S I Ensure the Transiate option is selected and enter a value of -81in Y.
Move... . .
¢ Click OK to move the Point.
e Select Point B shown.
| Geometry ﬂ . .
Point S Ensure the Translate option is selected and enter a value of -33.25in Y.
Move... . .
e Click OK to move the Point.
e Select the two Lines shown. If §
necessary zoom in to make the b
selection easier.
|Geso$fz?e' S 8] Ensure the Transiate option is
By Sweeping... selected and enter a value of -81in Y.
Click OK to sweep the Lines to create
the Surfaces.
Select these 2 lines
e Select the Point shown. b
|Ge§;:§"y — 2] Ensure the Translate option is
Move... selected and enter a value of 38 in X.

e Click OK to move the Point.

Select this point




| Geometry
Line >
By Poaints...
| Geometry
Surface >
By Lines...
| Attributes
Mesh >
Line...

Drained Nonlinear Analysis of a Retaining Wall

e Select the two Points shown. i

il Create a Line between the
two selected Points.

Select these points

e Select the Line just drawn i
along with the three Lines as
shown.

EI Create a Surface from the
four selected Lines.

9

@ Select'these 4 lines

Mesh Grading

e Define a Line mesh with element type None and 1 division.

e Enter the attribute name as Null 1 and click the Apply button to add the attribute to
the &% Treeview and keep the dialog active.




Modelling

e Define a Line mesh with 5 divisions.

e Select the Spacing button.

e Select the Uniform transition option and set the Ratio of first to last element to 4
e Click OK to accept the spacing properties.

e Give the attribute name as Null 5 Graded and click Apply to add the attribute to
the &% Treeview and keep the dialog active.

e Define a Line mesh with 10 divisions.
e Select the Spacing button.

e Select the Uniform transition option and set the Ratio of first to last element to
0.2

e Click OK to accept the spacing properties.
e Give the attribute name as Null 10 Graded and click OK to add the attribute to the
c&; Treeview.

Assigning the mesh attributes

|
|
OTOT0On
|
|
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Linesto assign Nuft.1 dataset

T

e Box-select the lines as shown and assign the mesh attribute Null 1.




Drained Nonlinear Analysis of a Retaining Wall

Note. The selection of some of the sets of lines as shown in the next two images is

best done by changing the selection cursor and

additionally using a special keyboard

shortcut which causes any lines passing through a box-selection to be selected.

To prepare for this:

M Change the cursor to the Select Lines cursor.

e Hold down the ALT key and 1
box-select each set of

horizontal lines as shown in the

preceding image and assign the

mesh attribute Null 5 Graded.

Note. Pressing the Shift key at
the same time as the ALT key will
allow extra lines to be added to a

lassign Null'5 graded dataset

selection
Linesto
-
| I
e Select the remaining lines as L
shown and assign the mesh bt

attribute Null 10 Graded.

N

Note. See the Keyboard Shortcut
Guide for more details on the use of
keyboard shortcuts.

Linest

R

o———————
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| Attributes

Material
Isotropic...

Modelling

e Turn on the Mesh layer in the  §
Treeview to see the mesh. Pt

Note. If the mesh is graded with the smaller elements at the wrong end of a line
reverse the line by selecting the line using the Geometry>Line>Reverse menu
selection. If errors have been made in mesh assignments simply re-select any lines with
an incorrect mesh assignment and re-assign the correct line mesh.

Material Properties

An isotropic elastic material will be used for the retaining wall while an isotropic
nonlinear material utilising the Mohr-Coulomb failure surface will be used for the soil.

With the Elastic tab selected enter the isotropic material properties for the wall as
Young’s Modulus 28E6 kN/m? Poisson’s Ratio 0.15 and Mass Density 2.03874
tonne/m®.

e Enter the attribute name as Concrete Wall.

e Click the Apply button to add the attribute to the & Treeview and keep the dialog
active.

e With the Elastic tab selected enter the isotropic material properties for the soil as
Young’s Modulus 1*y mod, Poisson’s Ratio 0.2 and Mass Density 2.03874
tonne/m®,

Note. The 1*y mod indicates that the Young’s Modulus is defined by a variation
scaled by a factor of 1. As an alternative to typing in the formula, enter 1 in the grid
location and click on the ® button. Select the y_mod variation from the drop down list.




Drained Nonlinear Analysis of a Retaining Wall

e Click the Plastic option and from the Model drop-down list select the Mohr-
Coulomb (model 65) entry.

e Enter an Initial cohesion value of 0

e Enter an Initial friction angle value of 25

e Enter an Final friction angle value of 25

o Enter a Dilation angle value of 25

¢ In the tension section enter a Cohesion hardening value of 0

¢ In the tension section enter a Limiting plastic strain value of 1000
e Enter the attribute name as Nonlinear Soil

e Click the OK button to add the attribute to the & Treeview.

Isotropic
¥ Plastic [~ Creep ™ Damage ™ shrinkage ™ wiscous ™ Two phase
Elastic Plastic |
IMohr-Cou\omb imadel 65) j Yalue
Iritial cohesion 0
Initial friction angle 25
Final friction angle 25
Dilation angle 25
—Hardening
Cohesion hardening Limiting plastic strain
1 a : 1000
il
Name [Monlineat soil j é’ (new)
ok | cancel | appy | hep

Assigning material properties

To assign the material properties groups will be used. Groups are very useful in
allowing features of the model to be turned-on and off to aid the assignment of
attributes or the viewing of results on selected features of the model.

10



| Geometry
| Group >
New Group...
| Geometry
Group >
[ New Group...

Modelling

il Change the cursor back to the normal cursor.

o Select the ten surfaces that form the retaining wall as shown.

i

P

i
T
T
|
T
1
Il
]
|
T
\
1
L

4

Surfacesto assign GoncreteWall matekial

NOTE: Mesh not shown for clarity

Create a group containing the wall elements only and rename it Wall. Click OK.

e With the ten surfaces of the wall still selected drag and drop the material attribute

Concrete Wall from the & Treeview onto the selection. With the Assign to
surfaces option selected click OK to assign the material attribute.

o Inthe L=l Treeview right-click on the Wall group and select Invisible.

e Select the whole visible model by pressing the Ctrl-A keys.

Create a group containing the soil elements only and rename it Soil. Click OK.

e Drag and drop the material attribute Nonlinear Soil from the & Treeview onto the
selection. With the Assign to surfaces option selected click OK to assign the
material attribute.

e Inthe L2l Treeview right-click on the Wall group and select Visible.

Supports

Define supports to prescribe zero horizontal displacement as well as zero horizontal and
vertical displacement.

11



| Attributes

Support...

Drained Nonlinear Analysis of a Retaining Wall

Click on the option to fix the Translation in X.

Enter the attribute name as Fixed in X and click the Apply button to add the
attribute to the &% Treeview and keep the dialog active.

Click on the option to fix the Translation in Y.

Enter the attribute name as Fixed in X and Y and click the OK button to add the
attribute to the & Treeview.

Assign the supports to the model.

Select the vertical Lines on the left-hand side and right-hand side of the model and

drag and drop the support attribute Fixed in X from the &b Treeview onto the
selection. With the Assign to lines option selected click OK to assign the support

attribute to All loadcases.

Select the Point which
represents the top-left
corner of the concrete
wall as shown and
drag and drop the
support attribute Fixed
in X from the &b
Treeview onto the
selection.  With the
Assign  to  Points
option selected click
OK to assign the
support attribute to All
analysis  loadcases.
This support
represents the prop.

Select the 3 horizontal
Lines representing the
bottom limit of the soil
and drag and drop the
support attribute Fixed

B ‘\i EE
™ Select this Paint
N Ma\e\ec IS PoIn
\\\

- \

- \ .
- \

_:I’TTW 1 \T 1

in X and Y from the &b Treeview onto the selection. With the Assign to lines
option selected click OK to assign the support attribute to All analysis loadcases.

12



| Attributes

Modelling

| Loading...

| Attributes

| Loading...

Loading

The initial in situ ground conditions must be established in the first loadcase of the
analysis. This is carried out using a stress and strain type load and a gravity (body
force) load.

e Select the Stress and Strain option and click Next

e On the Stress and
Strain dialog ensure - Usage
the Stress And Strain &' Element description = 1;;'_':19
Type is set to Initial € Point € Line & Suface € Yolume giy Vel
e Selecta Surface [ Inehi prs B e
element description IPlane i ] e
|3 dimensional j Ez

e Select Plane strain
from the drop down

list |

—Stresz and Strain Type
& |ritial
" Residual [ML anly)

€ Element name

e Enter 1*sig_h for Sx.
(This can be done
most easily by clicking

in the rlght-hgnd side = =] rew
of the Sx field and
selecting the variation

< Back | [t Finizh Cancel | Apply | Help |

attribute  from  the
drop-down list)

e Enter 1*sig_v for Sy.

e Enter 0 for Sxy

e Enter 1*sig_h for Sz. The remaining fields may be left blank (to signify zero)
e Enter the attribute name as In situ stress and click Finish.

e Select the Body force tab from the Structural Loading dialog and click Next
e Enter —9.81 in Linear acceleration in Y Dir.

e Enter the attribute name as Gravity and click Finish.

Assign the loads to the model.
The in-situ stress is to be assigned to the whole model:

13



| Attributes

Drained Nonlinear Analysis of a Retaining Wall

| Birth and Death...

o Select the whole model by pressing Ctrl-A and drag and drop the loading attribute

In situ stress from the &b Treeview onto the selection. With the Assign to
Surfaces option selected rename the loading attribute to Loadcase 1 and click OK.

Gravity is assigned to the whole model

o With the whole model selected drag and drop the loading attribute Gravity from the

& Treeview onto the selection. With the Assign to Surfaces option selected click
OK to assign the loading attribute to Loadcase 1

e In the I=F Treeview drag and drop the Geometry layer name beneath the Attributes
layer name.

Birth and Death

The Birth and Death feature must be used to simulate the removal of soil during
excavation in front of the wall. Excavation will take place over eight loadcases.

e Select the Deactivate tab and click Next. Select Percentage to Redistribute and
ensure the value is set to 100%. Enter the attribute name as Excavation.

e Click Finish to add the attribute to the c&: Treeview.
Assign the deactivation to the model.

o Use the zoom-in button to enlarge the view of the top-left corner of the model.

. |i||f necessary, for clarity, turn -off the display of the loading by pressing the
loading on/off button.

e Select the top surface representing the first
layer of soil to be removed in front of the
retaining wall and drag and drop the
deactivation attribute Excavation from the
& Treeview onto the selection. With the
Assign to surfaces option selected enter the
Loadcase name as Excavation to -1.50m
and click OK to assign the attribute.

=

WP L

L

|

e Select the next surface down in front of the
wall and drag and drop the deactivation  —
attribute Excavation from the &% Treeview
onto the selection. With the Assign to surfaces option selected enter the Loadcase
name as Excavation to -3.00m and click OK to assign the attribute.

14



Modelling

Note.

Repeat this procedure, selecting the next
surface down each time and renaming the
loadcases Excavation to -5.00m, Excavation
to -7.13m, Excavation to -9.26m,
Excavation to -11.26m, Excavation to -
13.26m and Excavation to -15.26m
respectively. The adjacent image shows the
final excavation assignment made.
surfaces

Deactivated (and hence

elements) can be visualised and checked by
setting each loadcase active in the (& Treeview.

Analysis Control

The use of a Mohr-Coulomb nonlinear material in this example dictates that a nonlinear
analysis control must be specified.

e Inthe & Treeview right-click on Loadcase 1 and rename it to In situ

o In the "2 Treeview right-click on In situ and select Nonlinear & Transient from

the Controls menu.

In the Incrementation
section:

Select the Nonlinear
option and choose

Manual incrementation.

In the Solution strategy
section:

e Set the Max number
of iterations to 50.

e Set the Residual force
norm to 0.01.

e Set the Incremental
displacement norm to
0.01.

Nonlinear & Transient

~ Incrementation

— Solution strategy

¥ Monlinear I Serie a5 previous [oedease
Incrementation Manual ]' Max number of iterations IED
Starting load factar 1 Residual force norm ID.DW
Max change in load factor 1] Incremental displacement norm ID 01
M ax total load Factor 1 Advanced |
[¥ | Adjist oad bavedion convergente Fistan
lterations per increment 4 ~ Incremental LUSAS file output
Options | Adianced 15| Sameias previous [nadease
Output fils |1
Thermal 'I
e Plot fils [
Initial time step o
Restart file ID
Tatal response time 100ER
! ber of d restark IU
I | Butaratic tine stepping e UMbt ol saveresials
Adyaniced. it I1
History file |1
b2 time steps of increments 1]
oK I Cancel | Help |

e Click OK to set the loadcase control.

15



| File

Drained Nonlinear Analysis of a Retaining Wall

| Save

Saving the model

El Save the model file.

Running the Analysis

| File

&

[New...

El Open the Solve Now dialog. Press OK to run the analysis.

A LUSAS Datafile will be created from the model information. The LUSAS Solver
uses this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the () Treeview

In addition, 2 files will be created in the Associated Model Data directory where the
model file resides:

U drained_wall.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U drained_wall.mys this is the LUSAS results file which is loaded
automatically into the Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, the output file will provide information relating to the nature of the
error encountered. A common mistake made when using LUSAS Modeller for the first
time is to forget to assign particular attribute data (geometry, mesh, supports, loading
etc.) to the model. Any errors listed in the output file should be fixed in LUSAS
Modeller before saving the model and re-running the analysis.

Rebuilding a Model

If errors are listed that for some reason cannot be corrected, a file is provided to re-
create the model information correctly, allowing a subsequent analysis to be run
successfully.

U drained_wall _modelling.vbs carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

16



Viewing the Results

e Enter the file name as drained_wall

| File To recreate the model, select the file drained_wall_modelling.vbs located in the
| Script S > \<LUSAS Installation Folder>\Examples\Modeller directory.
Run Script...

El Rerun the analysis to generate the results

Viewing the Results

Loadcase results can be seen in the () Treeview, and for a nonlinear analysis the load
case results for the last solved loading increment are set active by default.

o If present, turn off the Geometry, Mesh, Utilities and Attributes in the i
Treeview.

Wall Displacement

e Inthe G Treeview right-click on the results for Excavation to —13.26m and Set
Active.

¢ If not already on, add the Deformed mesh to add the deformed mesh layer to the
Treeview.

e In the panel at the bottom of the Treeview press the Deformations... button,
select the Specify factor option and specify a factor of 5. Press OK to return.

e Double click the View properties control in the Treeview. On the View tab
ensure the option to Show only activated elements is selected. Click OK to
visualise the deformed mesh for the active elements at increment 8, magnified by a
factor of 5.

17



Drained Nonlinear Analysis of a Retaining Wall

i
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A graph of the deformation of the wall toe over a range of loadcases will now be
created using the graph wizard.

e Zoom into the top left-hand side of the model and select the node at the wall toe.

| Utities * With the Time history option ., ...
|Graph Wizard... selected click Next. Leec s node
Firstly define the data to be used for
the X axis.

e Selected the Named option and
click Next.

e Select Loadcase ID from the drop
down list and click Next.

Secondly define the data for the Y
axis.

e With the Nodal option selected and click Next.

e Select Displacement from the Entity drop down list and DX from the Component
drop down list.

18



| utilities

Graph Wizard...

Viewing the Results

e The selected node number will appear in the Specify node drop down list. Click
Next.

e Enter suitable text for the graph titles and click Finish to display the graph of
displacement of the wall toe towards the excavation.

Drained analysis of a propped retaining wall

o Horizantal displacement of wall toe

0.05

o
=]
q o

0158

Displacement
o

02
0328

0.3

[¥3) '] [¥3) m [¥3) =+ ¥l ¥l ¥l w ¥l [ [¥s) w ¥l m ¥l
— o4 m =T u w L w o
Loadcase (D

—&— Displacement X Node 275(2) / Loadcase I0(1)

. E] Close the graph window.
. Maximise the graphics window.

Surface Heave
e Select the node at the top of the back of the wall.

e With the Time history option .
selected click Next. t»

Firstly define the data to be used for
the X axis.

e Selected the Named option and  Select this node
click Next.

e Select Loadcase ID from the drop
down list and click Next.

Secondly define the data for the Y
axis.

e With the Nodal option selected and click Next.

e Select Displacement from the Entity drop down list and DY from the Component
drop down list.
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Drained Nonlinear Analysis of a Retaining Wall

e The selected node number will appear in the Specify node drop down list. Click
Next.

e Enter suitable text for the graph titles and click Finish to display the graph of heave
behind the wall.

Drained analysis of a propped retaining wall

Surface heave behind wall

.07
0.06
0.05
0.04
0.03
0.0z
0.0

Displacement

W @
Loadcase D
—®— Displacement ¥ Mode 753(4) / Loadcase IDEF)

. El Close the graph window then =101X] maximise the graphics window.

Plotting contours of plastic strain in the soil

Because the model contains elements with two different material properties the active
set on which results are to be plotted must be selected.

e Inthe Treeview right-click on the group name Soil and select Show Results >
Results Plots> Show Results Only On This Group

e With no features selected click the right-hand mouse button in a blank part of the
graphics window and select Contours to add the contours layer to the = Treeview.

e Select Plastic strain — Plane strain from the Entity drop down list and EPE from
the component drop down list.

e Select the Contour Range tab and set the Maximum to 0.01 (1% strain).

e Click the OK button to display contours of the plastic strain distribution around the
wall.

20



| Utilities

Viewing the Results

| Graph Wizard...

Analysis: Analysis 1

Loadcase: 8:Excavation to -13.26m, Increment 8
Results file: drained_wall~Analysis 1.mys

Entity: Plastic strain - Plane Strain

Component: EPE

0.0
1.25E-3
2. 5E-3

3.75E-3
5.0E-3
6.25E-3
7.5E-3
8.75E-3
0.01

Maximum 0.375332 at node 380
Minimum 0.0 at node 1

Prop Force

Firstly define the data to be used for the X axis. H

Secondly define the data for the Y axis. -

Turn off the display of the Deformed Mesh and Contours layers in the i
Treeview.

Turn on the display of the Mesh layer in the = Treeview.

In the Treeview right-click on the group name Wall and select Show Results >
Results Plots> Show Results Only On This Group

Right-click on the group Wall in the L=l Treeview and select Set as Only Visible.

Select the node at the top-left of the wall that is
supported by the prop in the X direction.

With the Time history option selected click
Next. ]

Selected the Named option and click Next. Select this node

Select Loadcase ID from the drop down list
and click Next.
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| utilities

Graph Through 2D...

Drained Nonlinear Analysis of a Retaining Wall

e With the Nodal option selected and click Next.

e Select Reaction from the Entity drop down list and RSLT from the Component
drop down list.

e The selected node number will appear in the Specify node drop down list. Click
Next.

e Enter suitable text for the graph titles and click Finish to display the graph of heave
behind the wall.

Drained analysis of a propped retaining wall

Prop force
1200 === = = e ——— = = e = == = = = = ——— =

100 b T L
e

0 I S R A e

Displacement

T T

P 1] SURS SRS NOURS . JUDPISUURUE SRS PPN RN NOPMISCORUE SIS OIS RO USRS SO SIS

o @
Loadcase ID
—®— Resultant Reaction Mode 751(8) / Loadease D7)

Note. The resultant reaction has been graphed in the above figure. Since the wall is
propped only in the horizontal (X) direction at this location (see Supports section) there
is no reaction in the vertical direction and therefore the resultant reaction is identical to
the horizontal reaction.

. El Close the graph window.
. Maximise the graphics window.

Bending moment in the wall at 10m Depth

Because the model contains elements with two different material properties the active
set on which results are to be plotted must be chosen.

e Turn off the Deformed mesh layers in the = Treeview, and restore the Geometry
layer by right-hand clicking on a blank area of the model view and selecting
Geometry.

e Ensure the Snap to grid option is selected and enter a value of 1 for Grid size.

e Click on OK.
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Viewing the Results

o With reference to the ruler on the edge of the view wiondow, draw a line with the
mouse through the wall at 10m depth as shown.

e Ensure the Active loadcase radio button is selected, and press Next:

e Select Resultant effects from 2D model and ensure that only the Bending stress
option is selected in the list and click Next.

slice Data | x|
(%' Resultank effects from 2D model
" Results component: " Resultant effects From slice
Enitity IDispIacement j [JMean normal stress Sz ;I
I ¢ [T = (B Mciending stress
omponen [ IMormal stress Sz
Transform  Sef... | Mone [IMean shear stress

[CJAckual shear stress

Calculate distance as angle
w 0.0

arceeptre ¥ 0.0

Z 0.0 LI

Width For corridar averaging  |0.0

< Back I Mext = I Cancel | Help |

o Enter suitable text for the graph titles and click Finish. A graph is drawn and the
bending moment (and other information) is displayed in the Text output pane.
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Drained Nonlinear Analysis of a Retaining Wall

Drained analysis of a propped retaining wall
Bending morment in wall (-10)

Mean Mormal Stress Sz{22)

-26000
o

0.4
0,45 fomeeei

o — W oo o m o]
=1 = = o & = bl
=1 =1 o o

Distance(21)
Bending Stress(23) / Distance(21)

20 Forces-moments

Loadcase "8:Increment 8

Eeszults File "drained wall~Analwvsi= 1 mys" (ID=1)
Axial force per unit width = —49 9059

Shear force per unit width = —148 842

Homent per unit width = 4. 2793E3

Section Depth 1.0

Hean normal stress Sz = —49.9059

Hominal bending stress = 25.6758E3

The bending moment reported is 4280 kN/m? per metre run of the wall.

This completes the example.
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